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CHAPTER 1

Prefacio

Este manual tem o objetivo de agrupar todas as informagdes sobre o {nclcomposer} de forma detalhada.

1.1 Publico alvo

Este manual é destinado a qualquer pessoa que deseja aprender a desenvolver aplicagdes para o middleware de
TV Digital [Ginga-NCL](http://www.ginga.org.br), independente de sua experiéncia em [NCL (Nested Context Lan-
guage)](http://www.ncl.org.br).

1.2 Requisitos

O tnico requisito que se espera do leitor sdo conhecimentos basicos de informatica.
Para tirar total proveito deste manual vocé precisard também de um computador com:

* Sistema operacional Linux, Windows ou MAC OS X.
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* Versdo mais atual do {nclcomposer} (disponivel em <http://composer.telemidia.puc-rio.br>) instalada e os plug-
ins padrdes habilitados.
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CHAPTER 2

Introducgao

2.1 Oque é NCL ?

Criada no [Laboratério TeleMidia](http://www.telemidia.puc-rio.br) da [PUC-Rio](http://www.puc-rio.br), a lin-
guagem [NCL (Nested Context Language)](http://www.ncl.org.br) é uma linguagem declarativa para autoria de docu-
mentos hipermidia baseados no modelo conceitual NCM - Nested Context Model. NCL define como objetos de midia
sdo estruturados e relacionados, no tempo e espaco.

2.2 O que é o NCL Composer?

O [NCL Composer](http://composer.telemidia.puc-rio.br) € uma ferramenta de autoria que visa facilitar o desenvolvi-
mento de aplicagdes multimidia interativas usando [NCL (Nested Context Language)](http://www.ncl.org.br). Para
isso, ele utiliza-se de vdarias abstra¢des graficas (visOes) que permitem ao autor focar em apenas um determinado
aspecto, durante cada fase distinta da autoria.

Com isso, o NCL Composer permite que usudrios ndo-programadores possam criar aplicacdes multimidia interativas.
Além disso, o NCL Composer também pode ajudar no ensino/aprendizado dos principais conceitos da linguagem NCL
e do modelo NCM.

2.3 Principais recursos do NCL Composer

 Edicao grafica de documentos NCL

* Edicao textual de documentos NCL

* Integracao com ferramentas de execucao

¢ Multiplataforma (Linux, Windows e MacOS)

Além disso, o NCL Composer foi desenvolvido com o objetivo de ser facilmente extensivel. Novas funcionalidades
podem ser facilmente adicionadas por meio de plugins.
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CHAPTER 3

Instalando o NCL Composer

3.1 Windows

Para instalar o NCL Composer em ambiente Windows:

« Caso contrario, a seguinte tela serd exibida:

& NCL Composer Installer: License Agreement L= et S|

@ Please review the license terms before installing MCL Compaser.
N

Edlipse Public License - v 1.0 -

THE ACCOMPANYING PROGRAM 15 PROVIDED UNDER THE TERMS OF THIS L
ECLIPSE PUBLIC

LICEMSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF
THE PROGRAM

COMSTITUTES RECIPIENTA€E™S ACCEPTANCE OF THIS AGREEMENT.

1. DEFINITIONS

"Contribution” means:

alin the rase of the initial Contribotar. the initial crode and i

Fig. 3.1: Instalando (Passo 1)

¢ Clique no botdo I Agree para aceitar a licenca do NCL Composer.

* Baixe a versdo mais atual do NCL Composer para Windows em: <http://composer.telemidia.puc-rio.br/en/

¢ O arquivo deve ter o nome na forma nclcomposer-installer-X.X.X.exe, onde X.X.X deve conter a versdo do NCL
Composer. Execute esse arquivo.

» Caso vocé tenha alguma versao anterior instalada, o instalador ird perguntar se deseja desinstald-la antes de



http://composer.telemidia.puc-rio.br/en/download
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* Apés aceitar a licenca do software, serd possivel escolher quais plugins serdo instalados na sua mdquina, por
meio da tela (em caso de divida ndo altere):

& NCL Composer Installer: Installation Options = L]

Chedk the components you want to install and unchedk the components
you don't want to install. Click Next to continue,

Selct tre type of nstal -

Or, select the optional MCL Composer Core (required) -
components you wish to install: Start Menu Shortcuts 3
Install Default Plugins
Textual View
ayout View
Properties View
Structural View
Outline View
Validator Plugin &

Cancel < Back || MNext > I

m

Space required: 44, 2MB

Fig. 3.2: Instalando (Passo 2)

* Clique no botdo Next, e serd possivel escolher o local onde o NCL Composer serd instalado:

& NCL Compaser Installer: Installation Folder (=] o -]

Setup will install NCL Composer 0. 1.4in the following folder. To install in a
different folder, dick Browse and select another folder, Click Install to start
the installation.

Destination Folder

Omposel Browse...

Space required: 44.2MB
Space available: 16.7GB

Cancel < Back || Install I

Fig. 3.3: Instalando (Passo 3)

* Por fim, o NCL Composer serd instalado, e a seguinte tela exibida:

 Caso ndo tenha ocorrido nenhum problema, feche o instalador. Serd possivel executar o NCL Composer através
do menu Iniciar->TeleMidia->NCL Composer.

3.2 Linux (Ubuntu/Debian)

Para instalar o NCL Composer em ambiente Linux (Ubuntu/Debian):

* Baixe a versdao mais atual do NCL Composer para Linux (Ubuntu/Debian) em: <http://composer.telemidia.
puc-rio.br/en/download>

* O arquivo deve ter o nome na forma nclcomposer_X.X.X_i386.deb, onde X.X.X deve conter a versdo do NCL
Composer. Para instalar o arquivo que foi baixado, execute o seguinte comando na linha de comando:

Chapter 3. Instalando o NCL Composer


http://composer.telemidia.puc-rio.br/en/download
http://composer.telemidia.puc-rio.br/en/download

NCL Composer Documentation, Release 0.4.0

& NCL Composer Installer: Completed = ——

Completed

Show details

=]

Fig. 3.4: Instalando (Passo 4)

’$ dpkg -1 nclcomposer-X.X.X.deb ‘

 Caso a instalag@o ocorra sem problemas, é possivel acessar o NCL Composer através do menu de aplicacdes,
ou por meio do comando:

’$ nclcomposer ‘

3.3 MacOS

Para instalar o NCL Composer em ambiente MacOS:

* Baixe a versdo mais atual do NCL Composer para MacOS em: <http://composer.telemidia.puc-rio.br/en/
download>

* O arquivo deve ter o nome na forma nclcomposer-X.X.X-YYYYMMDD.dmg, onde X.X.X deve conter a versao
do NCL Composer e YYYYMMDD a data do langcamento.

Note: O release do NCL Composer para MacOS € realizado através de um arquivo [DMG](https://pt.wikipedia.org/
wiki/.dmg). O arquivo DMG € uma imagem de disco, que se assemelha a um arquivo compactado (ZIP ou RAR).
Dessa forma, para instalar a aplicago € necessario extrai-la de dentro do aquivo DMG.

e Para instalar (extrair) o NCL Composer, clique duas vezes no arquivo DMG baixado. Assim, uma janela serd
exibida contendo a aplicagao do NCL Composer. Clique e arraste a aplicagdo do NCL Composer para dentro da
pasta de aplicacdes do sistema (normalmente /Applications/).

¢ Pronto!

Note: Este processo é semelhante para qualquer arquivo DMG. Caso queira assitir um video explicativo, acesse o
[Doutor Apple](https://www.youtube.com/watch?v=gNgDTE7Vvwc).

3.3. MacOS 7


http://composer.telemidia.puc-rio.br/en/download
http://composer.telemidia.puc-rio.br/en/download
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CHAPTER 4

Executando o NCL Composer

As duas formas mais comuns de iniciar o NCL Composer sio clicando no icone do NCL Composer (por exemplo, na
Area de Trabalho ou no Menu Iniciar) ou através de uma linha de comando.

4.1 Plataformas conhecidas

As plataformas nas quais € sabido que o NCL Composer funciona sdo: “GNU/Linux”, “Apple Mac OS”, e “Microsoft
Windows”.

4.2 Linguas

Atualmente o NCL Composer estd disponivel em trés linguas: Inglés, Portugués e Espanhol. E possivel alterar a
lingua corrente em Edit->Preferences->General.

4.3 Argumentos da linha de comando

Ao executar o NCL Composer por meio de uma linha de comando, os seguintes argumentos sio reconhecidos.

--help, -h
Mostra a lista de opcoes.

——-version, -v
Mostra a versao.
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CHAPTER B

Conceitos Basicos

A linguagem NCL—e, consequentemente, 0 NCL Composer—baseiam-se no modelo NCM (Nested Context Model)
para modelar aplica¢gdes multimidia interativas. Esta secdo discute os principais conceitos do NCM e da NCL, os quais
sdo tteis para utilizar o NCL Composer de forma eficiente.

5.1 NCM

5.1.1 Nos e elos

No NCM, aplicagdes multimidia sio modeladas por meio de nés (nodes) e elos (links) (Figura 1).

Os néds de midia representam os objetos de midias da aplicagdo (videos, imagens, textos etc.), enquanto os elos
representam relacionamentos entres esses nés. Exemplos de relacionamentos entre os nés sdo os relacionamentos
causais (por exemplo, no NCM € possivel criar um elo entre dois nds, informando que quando a apresentacdo de um
né comecgar, a apresentacdo de outro né também deve ser iniciada).

O/"*d Y

e\

Além dos nés de midias, 0 NCM também permite agrupar nds e links em nds de composicao (ou contextos), que
permitem agrupar logicamente os nés e elos de uma aplicagdo. Contextos podem também agrupar outros contextos,
recursivamente (veja figura abaixo).

11
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Modelar uma aplica¢do multimidia no NCM entio € definir quais os objetos de midia fazem parte da aplicacdo (através
dos nés de midia), como eles estdo estruturados (definindo-se nés de contextos) e quando esses objetos de midia
serdo apresentados (o que € realizado por meio da defini¢do de elos entre os nés de midia).

5.1.2 Propriedades, regioes e descritores

Objetos de midia podem conter um conjunto de propriedades. Propriedades definem varias caracteristicas dos ob-
jetos de midia, como, por exemplo, o seu posicionamento (propriedades top e left), a sua dimensdo (propriedades
width e height), a sua transparéncia (propriedade transparency) etc. Para uma lista completa das propriedades
suportadas pela NCL é possivel consultar o [NCL Handbook](http://handbook.ncl.org.br/doku.php?id=property#
predefined-properties). Propriedades também podem ser modificadas dinamicamente durante a exibi¢do do objeto
de midia.

As propriedades de um objeto de midia sdo definidas no préprio objeto de midia. Porém, a NCL também define dois
outros elementos que possibilitam reusar um conjunto de propriedades em mais de um objeto de midia, sdo eles: a:
descritores e regioes.

Um descritor ¢ usado para agrupar um conjunto qualquer de propriedades e, assim, € possivel compartilha-las por mais
de uma midia. Por exemplo, se duas midia tocam na mesma regido da tela e com a mesma transparéncia, podemos
criar um descritor meudescritor que agrupa essas propriedades. Em vez de defini-las novamente para cada um dos
objetos de midia, cada objeto de midia pode apenas referenciar este descritor.

Uma regiao permite agrupar o conjunto de propriedades espaciais de um objeto de midia. Além disso, por meio de
regides também € mais facil definir

5.1.3 Portas e ancoras

5.1.4 Conectores

5.2 O software NCL Composer

O NCL Composer é uma feramenta de autoria para aplica¢cdes multimidia baseada no NCM. Por meio do NCL Com-
poser é possivel criar uma aplicagdo multimidia através de diversas visdes sobre um documento NCL. Cada visao traz
alguma representacio diferente do documento NCL que permite visualizar/editar algumas caracteristicas especificas.

Atualmente, as principais visdes do NCL Composer sao: Visao Estrutural, Visdo de Leiaute, Visao de Outline, Visdo
Proprieades, Visdo de Regras, Visdo de Validacdo e Visdo de Execucio.

12 Chapter 5. Conceitos Basicos
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CHAPTER O

Exemplo 01: Reproduzindo um objeto de midia

6.1 Objetivo

Neste primeiro exemplo, o objetivo é apenas exibir um objeto de midia, em tela cheia.
Para isso, iremos:

1. Criar um novo projeto;

2. Adicionar o objeto de midia (no exemplo, usaremos um video) na aplicaco;

3. Informar que esse objeto serd iniciado quando a aplicagdo comegar, e

4. Determinar a regido da tela onde esse objeto de midia serd exibido.

6.2 Passo 0: Criando um novo projeto

Para criarmos o nosso exemplo, o primeiro passo é criarmos um novo projeto.
Ao abrir o NCL Composer, a seguinte tela de boas-vindas € apresentada:

Nessa tela, é possivel criar um novo projeto por meio do menu File-&gt;New Project, por meio do botdo New Project
no canto esquerdo inferior da tela de boas-vindas, ou simplesmente pressionando Ctrl+N.

Feito isso, a seguinte janela serd exibida:

Atribua um nome para o projeto que vocé estd criando (aqui atribuimos o nome exemplo-01), selecione o diretério onde
deseja salvé-lo e deixe as opgdes Copy and Import the default Connector Base (Copie e importe a base de conectores
padrdo) e Add a default region to the project (adicione uma regido padrdo ao projeto) selecionadas.

Note: Nas proximas se¢des serdo discutidos em detalhes o que sdo os conectores e bases de conectores. Por enquanto,
apenas deixe esta op¢do marcada, pois ela serd ttil para os préximos exemplos.

Por fim, pressione o botdo Finish, e o seu novo projeto serd criado e aberto.

13
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NCL Composer

File Edit View Share Help

Getfing Started

Recent Projects Learn NCL
© hello-world-00.cpr Q Book: Programming in NCL 3.0 {in Portuguese)

Jhome/roberto/hello-world-00.cpr B L N
@ Introduction to Digital TV and to Ginga-NCL

© hello-world.cpr © Curso Ginga Brasil 2011

J/home/roberto/hello-world.cpr

Developers

© olamundo.cpr © NCL composer Official Web Site
/home/roberto/olamundo.cpr

© Extending NCL Composer through plugins
© testez.cpr
J/home/roberto/teste2.cpr

NCL Specifications

© NCL 3.0 Part 8 - NCL Digital TV Profiles
O testecpr
J/home/roberto/teste.cpr @ NCL3.0 Part 9 - NCL Live Editing Commands

More...

New Project W open Project

Fig. 6.1: Tela de boas-vindas do NCL Composer.

Introduction and Location

This wizard will help you to create a new NCL Composer Project.

Name: exemplo-01|

Createin:  /t rober Browse...

Other Preferences
Copy and Import the default Connector Base

Add a default region to the project

Finish Cancel

Fig. 6.2: Criagdo de um novo projeto.
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A animacgdo a seguir exemplifica a criacdo de um projeto.

Fig. 6.3: Criando um novo projeto.

Ao criar o novo projeto, o NCL Composer ird automaticamente abri-lo, onde teremos acesso as visdes: Visao Estrutu-
ral, Visao de Leiaute, Visao de Outline, Visdo Proprieades, Visdo de Regras, Visao de Valida¢do e Visdo de Execugao.

6.3 Passo 1: Adicionando um objeto de midia (O que?)

Com o nosso projeto criado e aberto, podemos comecar a desenvolver a nossa aplica¢cdo. Como primeiro passo, temos
que adicionar o objeto de midia da nossa aplicagdo (neste primeiro exemplo, teremos apenas um objeto de midia, um
video).

Para inserir os objetos de midia (dudio, video, imagens etc.) em nossa aplicacdo, a forma mais simples € apenas
arrastd-los do seu gerenciador de arquivos para dentro da Visao Estrutural do NCL Composer.

Drag and Drop

background 2rg badigroundrohi: png

an

A,
o™
——r carzan, a _ c _
Jr—— dntany
Tl 1
—J
dribkemz4 encompraunm
*‘I £ I
{
[

L “arverd e st | B WA 1 o saaee= 1,4 0

Semeanl ] Waliabie Corigaralys Vatlae

Fig. 6.4: Arraste o objeto de midia do seu gerenciador de arquivos para a Visdo Estrutural do NCL Composer para
inseri-lo como objetos de midia da aplicacdo

Note: Outra forma de inserir um objeto de midia, na Visdo Estrutural é clicar com o botdo direito sobre o corpo do
documento e selecionar o menu Insert -> Media. Neste caso, é importante ndo esquecer de definir o caminho para
o objeto de midia, o que poder ser realizado selecionando o objeto que vocé acabou de editar e alterando o valor do
atributo src (ou na Visdo de Propriedades ou na Visdo Textual).

A animacio a seguir, exemplica como podemos adicionar um novo objeto de midia, arrastando a partir do gerenciador
de arquivos.

6.3. Passo 1: Adicionando um objeto de midia (O que?) 15
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6.4 Passo 2: Informando o objeto de midia que serao inicialmente
exibidos (Quando?)

Para informar que o objeto de midia que acabamos de inserir deve iniciar quanto a nossa aplicacdo iniciar, € suficiente
criarmos uma porta no corpo do documento, mapeando-a para o objeto de midia. As portas de um contexto (inclusive
do corpo do documento, que nada mais € do que o contexto inicial do documento) definem quais os objetos daquele
contexto serdo iniciados quando aquele contexto for iniciado.

Para inserirmos uma porta no corpo do documento pela Visdo Estrutural é suficiente clicarmos com o botdo direito
sobre o corpo e selecionarmos o menu Insert->Port.

NCLComposer

Fle Edit View Share Help *exemplo-01.cpr X

Outline View © X NCL Structural View (Next) © X
=/ ncl (myNCLDocID) ia | ah ! ™ E 7
=) 2 S 2 @
- head oo (N R LR gé?() . 9/
- regionBase (regionBaseD)
region (region0)
=/ connectorBase [connBaseld) u} oo i oz 0
importBase B B
9 media (animGar}
ani.
Froperties View € %
body:myBodylD m} u}
Attribute Value # Insert >| &l Media
id myBodylD
# Context - o
N\ B switch / L A
# Body
Property
. L Port [y
Rules View © X i Delete Del |
Element 1d Variable COMP 44/ T2ke 2 Snapshot..
| AN | ko

Para mapearmos a porta que acabamos de criar para o objeto de midia, podemos selecionar a ferramenta Link na barra
de tarefas e clicar sobre a porta e, mantendo o botdo do mouse pressionado, arrastar o ponteiro até o objeto de midia.

Note: Outra forma de ativar a ferramenta Link € segurando a tecla SHIFT enquanto faz-se 0 mesmo procedimento
acima.

Com isso, ja definimos que nossa aplica¢do é constituida apenas de um objeto de midia e que quando a aplicacio
comecgar, esse objeto de midia serd executado.

A animacio a seguir exemplica como criar e mapear uma porta no corpo do documento.

6.5 Passo 3: Definindo a regiao onde o objeto de midia sera apresen-
tado (Onde?)

Para finalizar este primeiro exemplo s6 falta agora definirmos onde (em que regido da tela) o objeto de midia da nossa
aplicacdo serd exibido.

Como ao criarmos 0 nosso projeto, deixamos a op¢ao “Add a default region to the project” selecionada, ao criarmos
0 projeto ja criamos também uma regido que ocupa toda a tela.

16 Chapter 6. Exemplo 01: Reproduzindo um objeto de midia
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NCLComposer

File Edit View Share  Help *exemplo-0l.cor

Outline View © X INCL Structural View (Next) © X

- nel {myNCLDo«ID} . = =] 20 . - ~ Za
- head oo % % - = - \9/
- regionBase (regionBase0)
region (region0}
- connectorBase (connBaseld)
importBase
- [7) body (myBodyID}
[

—

media (animGar)

Properties View © X

port:p0 (The attribute ‘component’ is manc
Attribute Value |
id po

companent

interface

Rules View © X

Element Id Variable Comparator Value

Fig. 6.5: Mapeando porta para objeto de midia.

Fig. 6.6: Mapeando porta para objeto de midia.

Para associarmos a midia que adicionamos no nosso projeto a essa regido, basta arrastamos essa midia (por exemplo,
a partir da visao de outline) para a regido na vis@o de leiaute. Veja a animagao a seguir:

Fig. 6.7: Associando uma media a uma regido.
Ao fazermos isso, 0 NCL Composer ird nos perguntar se queremos “copiar os dados da regiao” para a midia ou se
queremos criar um descritor. Um descritor serve para podermos reusar as mesmas propriedades em mais de uma midia.

Exemplos destas propriedade sdo o posicionamento e a largura e a altura do objeto de midia. Na grande maioria das
vezes (inclusive aqui) iremos querer criar um descritor.

6.6 Passo 4: Executando o exemplo

Feito isso, 0 nosso primeiro exemplo ja estd completo.

Para executd-lo, basta executar o projeto no botdo “Run NCL Project” ![](../img/run-button.png) na Run view.

6.6. Passo 4: Executando o exemplo 17
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Fig. 6.8: Executando a aplicacdo.
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CHAPTER /

Exemplo 02: Reproduzindo um video e uma imagem

7.1 Objetivo

O objetivo deste exemplo € apresentar um video e uma imagem na tela.

Para isso, iremos:
* Adicionar os dois objetos de midia (um video e uma imagem) na nossa aplicacao;
¢ Criar duas regides (uma para cada objeto) e associd-las aos objetos de midia; e

¢ Informar que os dois objetos devem ser apresentados quando a aplicacdo comecgar.

7.2 Passo 1: Adicionando os objetos de midia (O que?)

Neste exemplo, queremos uma aplicagdo com dois objetos de midia (um video e uma imagem). Para inseri-los no seu
projeto, basta arrastar as duas midias do seu gerenciador de arquivos para a Visao Estrutural do NCL Composer.

Note:  Caso precise de mais informagdes sobre como criar um novo projeto veja o [Passo 0 do Exemplo
01](01.hello_world).

7.3 Passo 2: Onde os objetos de midia serao apresentados

Agora iremos definir onde os objetos de midia serdo apresentados. Para isso iremos criar regides na tela, por meio da
Visdo de Leiaute e associar os objetos de midia a essas regides.
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7.3.1 Criando as regioes

Como podemos perceber ao acessar a Visdo de Leiaute, por padrdo, o NCL Composer ja cria uma regido region0 que
ocupa toda a tela. Iremos reusar essa regido para o video (queremos que ele ocupe toda a tela) e iremos criar uma
nova regido para a imagem. Para isso, podemos clicar com o botdo direito do mouse na regifio existente e acessar a
opcao Add region do menu contextual. Uma nova regido serd criada, e podemos agora redimensiond-la e posiciona-la
da forma que nos convier.

7.3.2 Associando os objetos de midia as regioes
Depois de criarmos as regides, agora devemos associar cada um dos objetos de midia (o video e a imagem) a cada uma

das suas regides. Para isso, basta arrastar o objeto de midia a partir da Visao de Outline para a sua respectiva regido na
Visdo de Leiaute.

7.4 Passo 3: Quando os objetos de midia serao apresentados

Como os dois objetos de midia iniciardo no comeco da aplicagdo, uma forma simples de definir esse comportamento
¢ criando-se uma porta para cada um desses objetos.

Diferente de objetos de midia de video e dudio, objetos de midia estaticos—como, por exemplo, imagens—nao pos-
suem duragdo implicita. Neste caso, caso iniciemos sua execucao ela sendo apresentada indefinidamente. Para definir-
mos a dura¢do de uma midia (por exemplo, uma imagem) de forma explicita podemos o atributo explicitDur no
descritor associado a esta midia (veja a animagdo abaixo, onde definimos que a imagem ird durar 5s).

7.5 Passo 4: Executando o exemplo

Feito isso, 0 nosso exemplo ja estd completo e podemos executd-lo na Visdo de Execugdo.
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CHAPTER 8

Exemplo 03: Iniciando e terminando dois objetos de midia
simultaneamente

8.1 Objetivo

O objetivo deste exemplo € iniciar e terminar dois objetos de midia simultaneamente.
Para isso, iremos:
1. Adicionar os dois objetos de midia que fazem parte da aplica¢do (um video e uma imagem);

2. Criar duas regides, uma para o video e uma para a imagem, e associar os respectivos objetos de
midia a suas regioes;

3. Informar que o video comegard a ser apresentado no inicio da aplicacdo; e
4. Criar dois elos:
* Um informando que a imagem iniciard sua apresentagdo quando o video comegar a ser executado; e

¢ Qutro informando que a imagem ird terminar a sua execu¢do quando o video terminar a sua exe-
cugdo.

8.2 Passo 1: Adicionando os objetos de midia (O que?)

Da mesma forma que no exemplo anterior iremos arrastar os dois objetos de midia que ainda fazem parte da nossa
aplicacdo (um video e uma imagem) para a Visao Estrutural.

Fig. 8.1: Arrastando um video e uma imagem para a Visdo Estrutural.
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8.3 Passo 2: Onde os objetos de midia serao apresentados (Onde?)

Agora iremos definir onde os objetos de midia serdo apresentados. Para isso, iremos criar regides na tela por meio da
Visdo de Leiaute e associar os objetos de midia a essas regides.

8.3.1 Criando as regioes

Como podemos perceber ao acessar a Visdo de Leiaute, por padrdo, o NCL Composer ja cria uma regido region0 que
ocupa toda a tela. Iremos reusar essa regido para o video (queremos que ele ocupe toda a tela) e iremos criar uma
nova regifo para a imagem. Para isso, podemos clicar com o botdo direito do mouse na regifio existente e acessar a
op¢ao Add region do menu contextual. Uma nova regido serd criada, e podemos agora redimensiond-la e posiciona-la
da forma que nos convier.

Fig. 8.2: Arraste um video e uma imagem para a Visao Estrutural.

8.3.2 Associando os objetos de midia as regioes

Depois de criarmos as regides, agora devemos associar cada um dos objetos de midia (o video e a imagem) a cada uma
das suas regides. Para isso, basta arrastar o objeto de midia a partir da Visao de Outline para a sua respectiva regido na
Visdo de Leiaute.

8.4 Passo 4: Quando os objetos de midia serao apresentados: Links
(Quando?)

Para informar quando os objetos de midia serdo executados iremos:

* Criar uma porta para o video, informando que ele deve ser apresentado quando a aplicacdo iniciar sua execucio;
e

¢ Criar dois elos sincronizando a imagem com o video acima. O primeiro elo ird informar que a apresentacao
da imagem deve comecar quando a apresentacao do video comecar, ¢ o segundo elo ird informar que a
apresentacdo da imagem deve terminar quando a apresentacao do video terminar.

8.4.1 Informando o objeto que sera inicialmente apresentado
Para criarmos uma porta para o video principal podemos, na Visdo Estrutural, selecionar o body e pressionar o botao
Insert port na barra de ferramentas. Feito isso, teremos uma nova porta no body.

Para associarmos essa porta ao video de nossa aplicacdo podemos selecionar a ferramenta de link na barra de ferra-
mentas e clicar com o botdo esquerdo do mouse e (ainda segurando o botao) arrastar o ponteiro para o video.

Com isso, ja definimos que quando a aplicacio iniciar o video iniciara a sua apresentacio.
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8.4.2 Sincronizando o inicio e o fim do video com o inicio e fim da imagem

Para sincronizarmos a apresentacio do video com a apresentacdo da imagem, iremos usar elos. Para criarmos um elo
entre dois objetos de midia na Visdo Estrutural podemos:

1. selecionar a ferramenta de link na barra de ferramentes; e, depois

2. clicar com o botdo direito do mouse sobre o primeiro objeto de midia (no caso do nosso exemplo, o video),
mantendo o botao do mouse pressionado, arrastar o ponteiro até o segundo objeto (no nosso exemplo, a imagem).

Com isso, iremos criar um elo no qual o primeiro objeto clicado participard como parte da condi¢io, e a acdo serd
executada sobre o segundo objeto (para o qual arrastamos o elo).

Logo ap6s criarmos um elo com o procedimento acima, uma nova janela ird abrir, na qual poderemos detalhar as
informagdes desse elo. Em especial, devemos escolher qual o tipo de elo que estamos criando (ou seja, qual o
conector daquele elo) e quais as acdes e condicdes dos objetos que selecionamos. Geralmente, s6 modificamos as
acdes ou condigdes quando o elo que estamos criando possuir mais de uma condi¢do ou mais de uma agéo.

Note: Alguns tipos de elo também podem receber pardmetros (e.g. um pardmetro delay que informa com quanto
tempo depois de a condi¢@o satisfeita as acdo deve ser executada). E também podemos definir os valores desses
parametros na janela de criacdo de elos.

No caso do nosso exemplo, iremos escolher o tipo do primeiro elo onBeginStart (ou ao comecar “isto”, inicie
“aquilo”), informando que quando o primeiro objeto selecionado (o video) comecar a sua apresentacdo, queremos
que o segundo objeto (a imagem) também comece a sua apresentacao.

Para o segundo elo, iremos escolher o tipo onEndStop (ou ao terminar “isto”, termine aquilo). Dessa forma, iremos
informar que o final do video deve também disparar a finalizacdo da imagem.

8.5 Passo 5: Executando o exemplo

Pronto! O nosso Exemplo 03 estd pronto. Para testd-lo basta executd-lo na Visdo de Execucdo. O resultado deve ser
o inicio do video e da imagem no inicio da aplica¢do e os dois devem continuar apresentando até o final do video,
quando os dois devem ser finalizados, e a aplica¢do termina a sua execugao.

8.6 Passo 0: Salvar como...

Para reusarmos o que ja foi feito no exemplo anterior, vamos abri-lo e criar um novo projeto baseado nele, por meio
do menu File-&gt;Save as. . . .

8.5. Passo 5: Executando o exemplo 25
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CHAPTER 9

Telas e Menus do NCL Composer

9.1 Janela Principal

Barra de Titulo

o
Barra de Menus —— e et vew swe e BT — Barra de Projetos

I View (Next) © X

Area das Visdes

Valdator Plug-n © X
lemento [r

v m ° X ik
e

Barra de Perspectivas — et

9.1.1 Barra de titulo

Evidencia o nome do NCL Composer e do projeto corrente.

9.1.2 Barra de projetos

Lista a tela de boas-vindas e a lista de projetos abertos, permitindo navegar entre eles.
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9.1.3 Area das Visoes

Area de desenho das diversas visdes. Cada visao pode ter seus préprios elementos de interface. Também é possivel
organizar e salvar a disposi¢@o das diversas visdes por meio das perspectivas.

9.1.4 Barra de perspectivas

Apresenta as perspectivas salvas pelo usudrio e permite facilmente alternar entre elas.

9.1.5 Barra de menus

Mostra as entradas de menu disponiveis.
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File: Da acesso as seguintes opgdes:
* Novo projeto
* Abrir
* Salvar

Menu Screnshot
m Edit Wiew Share  Help
‘ Mew project Ctri+M
= Cpen Project Ctrl+0
Recent Projects > |
¥ save Ctri+s
Save As
Save All Ctrl+5hift+5
& Publish
Import »
Close Ctri+F4
Close All
Exit Ctrl+0Q

Edit:

File l;ﬂl View  Share  Help

Preferences

View:

File  Edit m Share  Help

Fullscreen

Main toolbar

Perspectives toolbar
Wiews

Restore a perspective

Save current perspective

F11

Share:

ple  gor view [ nen

Share This Project Online

Go to NCL Club Website

Help:

ple  eor view [ nen

5hare This Project Online

Go to NCL Club Website

9.1. Janela Principal
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9.1.6 Atalhos

Os atalhos globais (vélidos em qualquer visdo) do NCL Composer sdo:

9.2

“Ctrl‘‘+‘“n‘‘ - Novo projeto.

“Ctrl“+¢“o*¢ - Abrir projeto.

“Ctrl““‘+¢“s*¢ - Salvar o projeto corrente.

“Ctrl““+¢“Shift‘“+¢“s*¢ - Salvar todos os projetos abertos.

CCtrl““+¢“Alt“+¢“s¢ - Salvar comeo...: Salva o projeto corrente com outro nome.
“Ctrl*“+¢‘F4‘ - Fechar projeto.

“Alt+F4¢¢ ou ““Ctrl*‘+‘‘Q*¢ - Fechar o Inclcomposer].

““F11¢¢ - Habilita/desabilita visualizacio em tela cheia.

““F1¢¢ - Abre a ajuda do Inclcomposer|.

““F5¢ - Atualiza o modelo da visdao com foco.

CCtrle+e1¢¢, <“Ctrl*“+¢<2¢¢, ... - Alterna entre as perspectivas.

Visao Estrutural

A Visdo Estrutural permite que os autores de aplicagdes interajam visualmente com a estrutura 16gica do documento
NCL. Em NCL, a estrutura l6gica é representada pelos seus objetos (nds de contetido e nés de composicio) e os elos
entre esses objetos (representadas pelos elementos ).
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9.2.1 Acoes

As acgdes sdo as diversas atividades que o usudrio pode realizar durante o processo de autoria. Uma ac¢do pode ser
executada de vdrias formas: através da barra de ferramenta, do menu contextual, de um atalho de teclado, do mouse
e da combinacdo de varias dessas formas. Abaixo sdo descritas cada uma das acdes disponiveis na Visdo Estrutural e
como elas podem ser executadas.
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Acéo

Descricao

Des-
fazer

Desfaz a tltima ag@o realizada na visdo. Esta agfo é ignorada caso ndo exista nenhuma
acdo para ser defeita. Inserir, remover, mover e redimencionar sdo exemplos de acdes que
podem ser desfeitas. Por outro lado, selecionar ndo € uma acio que pode ser desfeita. Na
versao atual, ndo existe um limite na quantidade de acdes que podem ser desfeitas.

Esta acdo
pode ser exe-
cutada através
da: barra de
ferramentas
(#barra-de-
ferramentas),
menu con-
textual e
atalho.

fazer

Refaz a dltima acdo realizada na visdo. Esta ag¢do € ignorada caso nio exista nenhuma
acdo para ser refeita, ou seja, nenhuma acgdo foi desfeita anteriormente. Na versdo atual,
ndo existe um limite na quantidade de a¢des que podem ser desfeitas.

Esta acdo
pode ser exe-
cutada através
da: barra de
ferramentas
(#barra-de-
ferramentas),
menu con-
textual e
atalho.

Recor
tar

- Copia a entidade selecionada para a area de transferencia e remove ela da visao. Esta
acdo € ignorada caso nenhuma entidade tenha sido selecionada e se a entidade selecionada
é do tipo body.

Esta acdo
pode ser exe-
cutada através
da: barra de
ferramentas

(#barra-de-

ferramentas),
menu con-
textual e

atalho.

Copid

ir Copia a entidade selecionada para a area de transferencia. Esta acdo é ignorada caso
nenhuma entidade tenha sido selecionada e se a entidade selecionada é do tipo body.

Esta acido
pode ser exe-
cutada através
da:
ferramentas
(#barra-de-

ferramentas),
menu

barra de

con-
textual e

atalho.

lar

Adiciona a entidade copiada para drea de trdnsferencia como filha da entidade sele-
cionada. Esta acdo é ignorada caso nenhuma entidade tenha sido recortada ou copiada
e se a entidade selecionada nio permita que seja adicionado como um de seus filhos enti-
dades do tipo selecionada. Por exemplo, ndo € possivel colar um contexto em uma midia.

Esta acdo
pode ser exe-
cutada através
da: barra de
ferramentas
(#barra-de-
ferramentas),
menu
textual
atalho.

con-
€

Dele-
tar

Remove a entidade selecionada da visdo. Esta acdo € ignorada caso nenhuma entidade
esteja selecionada na visao.

Esta acdo
pode ser exe-
cutada através
do:

menu
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atalho.

Move

r Move a entidade selecionada para uma entidade de destino. Para a structural_view, mover
significa alterar o paréntesco da entidade selecionada. A entidade de destino € determinada

Esta acido
pode ser exe-
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9.2.2 Barra de Ferramentas

A partir da versdo 0.3.0 a Visdo Estrutural disponibiliza uma barra de ferramentas com as principais a¢des da visdo.

O, sl = == g%}ﬂ =9 . L g

0C00000000000000NDO6 O

A figura acima apresenta a barra de ferramentas, cujo detalhes de cada ferramenta sdo descritos a seguir:

¢ (a) - Desfazer: Desfaz a ultima agao realizada na visdo. Mais detalhes.

¢ (b) - Refazer: Refaz a tltima acdo reallizada na visdo. Mais detalhes.

¢ (c) - Recortar: Copia a entidade selecionada para a area de transferencia e remove ela da visao. Mais detalhes.
¢ (d) - Copiar: Copia a entidade selecionada para a area de transferencia. Mais detalhes.

* (e) - Colar: Adiciona a entidade copiada para drea de transferencia como filha da entidade selecionada. Mais
detalhes.

¢ (f) - Aumentar o *Zoom:* Aumenta o Zoom na visdao. Mais detalhes.

* (g) - Diminuir o *Zoom:* Diminue o Zoom na visdo. Mais detalhes.

¢ (h) - Tirar uma Foto: Exporta o projeto como imagem (.png). Mais detalhes.

¢ (i) - Ferramenta de Ponteiro: Altera o modo de edi¢do da visdo para “ponteiro”. Mais detalhes.

* (j) - Ferramenta de *Link*: Altera o modo de edicio da visao para “link”. Mais detalhes.

¢ (k) - Adicionar Midia: Adiciona uma entidade do tipo midia como filha da entidade selecionada. Mais detalhes.

* (1) - Adicionar Contexto: Adiciona uma entidade do tipo context como filha da entidade selecionada. Mais
detalhes.

* (m) - Adicionar *Switch*: Adiciona uma entidade do tipo switch como filha da entidade selecionada. Mais
detalhes.

* (n) - Adicionar *Body*: Adiciona um body na visdo. Mais detalhes.
¢ (0) - Adicionar Area: Adiciona uma entidade do tipo drea como filha da entidade selecionada. Mais detalhes.

* (p) - Adicionar Propriedade: Adiciona uma entidade do tipo propriedade como filha da entidade selecionada.
Mais detalhes.

* (q) - Adicionar Porta: Adiciona uma entidade do tipo porta como filha da entidade selecionada. Mais detalhes.

* (r) - Adicionar Porta de *Switch*: Adiciona uma entidade do tipo porta de swifch como filha da entidade
selecionada. Mais detalhes.

9.2.3 Menus

Menu Contextual
O menu contextual € exibido sempre que o usudrio clica com o botdo direito do mouse em qualquer entidade ou nas
areas vazias (em branco) da visdo.
A figura acima apresenta o menu contextual, cujo detalhes sdo descritos abaixo:
* (a) - Exibir Ajuda: Exibe o didlogo de ajuda. Desabilitado nesta versao.

¢ (b) - Insert: Exibe o submenu de adcao de entidades.
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9 Help F1

0 Insert b0 Media

o Undao Ctrl+Z " Context

e Redo Ctrl+Shift+Z | @ Switch

e Cut Ctrl+X ¢ B-Gdj."

o Copy Ctrl+C Area

9 Paste Ctrl+V Property
.

0 1 Delete Del Port

Switch Port
o I= Take a Snapshot...
o Properties

* (c¢) - Desfazer: Desfaz a ultima acgao realizada na visdo. Mais detalhes.

* (d) - Refazer: Refaz a dltima a¢@o reallizada na visdo. Mais detalhes.

* (e) - Recortar: Copia a entidade selecionada para a area de transferencia e remove ela da visdo. Mais detalhes.
¢ (f) - Copiar: Copia a entidade selecionada para a area de transferencia. Mais detalhes.

* (g) - Colar: Adiciona a entidade copiada para drea de trdnsferencia como filha da entidade selecionada. Mais
detalhes.

¢ (h) - Deletar: Remove a entidade selecionada da visdo. Mais detalhes.

¢ (i) - Tirar uma Foto: Exporta o projeto como imagem (.png). Mais detalhes.

* (j) - Exibir Propriedades: Exibe o didlogo de propriedades. Desabilitado nesta versao

¢ (k) - Adicionar Midia: Adiciona uma entidade do tipo midia como filha da entidade selecionada. Mais detalhes.

¢ (1) - Adicionar Contexto: Adiciona uma entidade do tipo context como filha da entidade selecionada. Mais
detalhes.

* (m) - Adicionar *Switch*: Adiciona uma entidade do tipo switch como filha da entidade selecionada. Mais
detalhes.

¢ (n) - Adicionar *Body*: Adiciona um body na visdo. Mais detalhes.
¢ (0) - Adicionar Area: Adiciona uma entidade do tipo drea como filha da entidade selecionada. Mais detalhes.

* (p) - Adicionar Propriedade: Adiciona uma entidade do tipo propriedade como filha da entidade selecionada.
Mais detalhes.

* (q) - Adicionar Porta: Adiciona uma entidade do tipo porta como filha da entidade selecionada. Mais detalhes.

* (r) - Adicionar Porta de *Switch*: Adiciona uma entidade do tipo porta de swifch como filha da entidade
selecionada. Mais detalhes.
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9.2.4 Dialogos

Dialogo de Link

O didlogo de link € utilizado para criacdo e edi¢do de: links, binds, pardmetros de link e parametros de binds. O didlogo
para criagdo de link € exibido quando um relacionamento entre uma entidade de origem e destino é especificado através

da ferramenta de criagdo de *link*.

Logo que exibido (figura abaixo), o didlogo de link apresenta uma lista de conectores para que o usudrio possa escolher.
A lista de conectores é carregada dindmicamente a partir das especificacdes da aplicacdo em desenvolvimento.

&:ﬁ Create Link

Link Properties
Connector:

[] show Params

Binds Properties
Condition:

[] show Params
Action:

[] show Params

X

connF¥onBeginAttributionPause A
connFonBeginAttributionPause_del.
connfonBeginAttributionResume
connfonBeginAttributionResume_...
connfonBeginAttributionSet_var
conn#FonBeginAttributionSet_varPa..
conn#FonBeginAttributionSet_varRe.,
connFonBeginAttributionSet_varStar
connFonBeginAttributionSet_varSto)
connFonBeginAttributionSet_var_d.. »

£ >

Assim que o usudrio comegar a preencher a caixa de texto “connector” (figura abaixo), a lista de conectores ¢é filtrada

para facilitar a sele¢do do conector apropriado.

tﬁ Create Link

Link Properties

Connector:

[] show Params

Binds Properties
Condition:

[] show Params
Action:

[ ] show Params

conn #nnBEginStI

connfonBeginStart A
conn#onBeginStartPause
conn#onBeginStartResume
connF¥onBeginStartSet_var
connF¥onBeginStartSet_var_delay_du
connFonBeginStartStop
connfonBeginStart_delay
connfonBeginStart_delay1Pause_del
connfonBeginStart_delay1Resume_c
conn#FonBeginStart_delay15et_var_d. v
< >

Uma vez selecionado um dos conectores na lista, o usudrio pode escolher qual o tipo de condi¢@o e ag¢do na secio
de binds do didlogo (figura abaixo). Os tipos de condicdes e acdes disponiveis sdo carregados a patir do conector

9.2. Visao Estrutural
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selecionado.

Ainda na criacao do link, quando o usudrio habilita a exibi¢cdo de parametros (“show params’), é possivel especificar
os valores dos parametros de link, parametros do bind de condi¢do e pardmetros do bind de acdo (figura abaixo) que
devem ser considerados para criagdo do relacionamento.

&) Create Link ? X

Link Properties

Connector: conn#FonBeginSstartset_var

Showe Params

Mame Value
war
Binds Properties
Condition: u anBegin hd
Show Params
Mame Value
war
Action: ':_P} start =

Show Params

Mame Value

war

Corcel

Para editar os pardmetros de um link, o usudrio deve clicar duas vezes na entidade do tipo link na visdo. Esta aclo
resultana exibi¢c@o do didlogo abaixo.

De modo semelhante, para editar um bind, o usuério deve clicar duas vezes na entidade do tipo bind, resultando na
exibi¢do do didlogo abaixo.
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@3 Edit Link ? e

Link Properties

Connector: conn#FonBeqginStart_delay

Show Params

Mame Value

delay

Binds Properties

Condition: Mot available x
Show Params

Action: Mot available -

Show Params

ok | cancel
Q Edit Bind (Condition) ? X
Link Properties
Connector: conn#onkeyselectionstartStop
Show Params
Binds Properties
Condition: | 9 onSelection hd
Showe Params
Mame Value
keyCode RED
Action: Mot available ¥
Show Params
oK | Cancel
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Referéncia
E possivel especificar uma referéncia através da acdo de colar. Assim que a acio de colar é realizada o didlogo

abaixo é exibido, solicitando que o autor escolha entre copiar ou criar uma referéncia da entidade copiada para drea
de tranferéncia.

£ Paste

Quando uma entidade é uma referéncia, ela fica levemente transparente (figura abaixo) e herda todas as interfaces da
entidade referenciada. Nao € possivel referenciar uma entidade que j4 referencia uma outra. Nesta versdo ainda ndo é
possivel fazer referéncia para entidades do tipo: contexto, switch e body.

r_Al

9.2.5 Atalhos

Abaixo segue a lista de atalhos da Visdo Estrutural:
o “Ctrl‘“+¢“z*¢ - Desfazer: Desfaz a tltima acdo realizada na visdo. Mais detalhes.
o “Ctrl“‘+““Shift‘‘+¢‘z‘ - Refazer: Refaz a dltima acgdo reallizada na visdo. Mais detalhes.

o “Ctrl“‘+¢“x*‘ - Recortar: Copia a entidade selecionada para a area de transferencia e remove ela da visdo.
Mais detalhes.

o “Ctrl““+““c** - Copiar: Copia a entidade selecionada para a area de transferencia. Mais detalhes.
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“Ctrl“+¢v¢¢ - Colar: Adiciona a entidade da drea de trdnsferencia como filha da entidade selecionada. Mais
detalhes.

‘““Del‘‘ - Deletar: Remove a entidade selecionada da visdo. Mais detalhes.
*Segurar* ‘‘Ctrl‘‘+*Drag-n-drop* - Mover: Remove a entidade selecionada da visdo. Mais detalhes.

“Ctrl“+¢¢+¢¢ ou “‘Ctrl‘‘+*Roda do mouse para cima* - Aumentar o *zoom*: Aumenta o zoom na visao.
Mais detalhes.

“Ctrl“+¢¢-¢ ou ““Ctrl‘‘+*Roda do mouse para baixo* - Diminuir o *zoom*: Diminue o zoom na visdo.
Mais detalhes.

¢¢1¢¢ - Habilitar Ferramenta de Ponteiro: Altera o modo de edi¢@o da visdo para “ponteiro”. Mais detalhes.

¢€2¢¢ ou *Segurar* ‘‘Shift‘‘ - Habilitar Ferramenta de Link: Altera o modo de edi¢do da visdo para “link”. Mais
detalhes.

¢3¢¢ - Adicionar Midia: Adiciona uma entidade do tipo midia como filha da entidade selecionada. Mais
detalhes.

““4¢¢ - Adicionar Contexto: Adiciona uma entidade do tipo context como filha da entidade selecionada. Mais
detalhes.

¢¢5¢¢ - Adicionar *Switch*: Adiciona uma entidade do tipo switch como filha da entidade selecionada. Mais
detalhes.

““6‘“ - Adicionar *Body*: Adiciona um body na visdo. Mais detalhes.
¢7¢¢ _ Adicionar Area: Adiciona uma entidade do tipo drea como filha da entidade selecionada. Mais detalhes.

¢“8¢‘ - Adicionar Propriedade: Adiciona uma entidade do tipo propriedade como filha da entidade selecionada.
Mais detalhes.

€“9¢¢ - Adicionar Porta: Adiciona uma entidade do tipo porta como filha da entidade selecionada. Mais detal-
hes.

““0‘‘ - Adicionar Porta de *Switch*: Adiciona uma entidade do tipo porta de switch como filha da entidade
selecionada. Mais detalhes.

“Ctrl‘‘+‘“m*‘ - Habilitar/Desabilitar Minimapa: Habilita/Desabilita o minimapa. Mais detalhes.

9.2.6 Outros detalhes

Todo plugins do NCL Composer permite sincronizar (ou resincronizar) o estado atual da visdo com o modelo do
ndcleo da ferramenta. Esta tarefa € realiza através de um botdo na aba de cada visdao. No caso da Visao Estrutural,
sempre que a visao € resincronizada com o modelo do nicleo da ferramenta, todo o histério de agdes € perdido, de
modo que ndo é possivel desfazer ou refazer uma acdo.

9.3 Visao de Leiaute

A Visdo de Leiaute permite que os autores de aplicacdes NCL interajam visualmente com as regides onde os objetos
de midia serdo inicialmente apresentados. Nesta visao, os autores podem criar e manipular as regides e a hierarquia de
regides do documento.
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: = '_. Region Bases: regionBasel v
(regiont) (region2)
(region3)
(regiond)
{regions)
o o 0
|le {region6) ﬁ
O o O
Acéao Descricdo
Criar Cria uma nova regido, filha regido que esta selecionada. Esta acdo pode ser executada através da:
uma
regido
Re- Remove a regido que estd atualmente selecionada e seus fil- | Esta acdo pode ser executada através da:
mover hos. barra de ferramentas
uma
regido
Copiar Copia a regido selecionada para a area de transferencia. | Esta a¢do pode ser executada através
regiao Esta acdo € ela da visdo. Esta acdo € ignorada caso nenhuma | da: barra de ferramentas (#barra-de-
entidade esteja selecionada. ferramentas), menu contextual e atalho.
Colar Cola a regido que estd na area de transferéncia como filha | Esta acdo pode ser executada através
regiao da regido selecionada. da: barra de ferramentas (#barra-de-
ferramentas), menu contextual e atalho.
Es- Esconde a regido atualmente selecionada da visdo de leiaute. | Esta acdo pode ser executada através
conder A regido continua existindo no modelo (e pode ser mostrada | da: barra de ferramentas (#barra-de-
regido depois) apenas nao € visualizada. ferramentas), menu contextual e atalho.
Mostrar/escOngta a entidade selecionada para a area de transferencia. | Esta acdo pode ser executada através
r grade Esta acdo € ignorada caso nenhuma entidade tenha sido se- | da: barra de ferramentas (#barra-de-
lecionada e se a entidade selecionada € do tipo body. ferramentas), menu contextual e atalho.
Tirar Permite salvar uma imagem com a disposicdo atual das | Esta acdo pode ser executada através
um regides da visdo de leiaute. da: barra de ferramentas (#barra-de-
instan- ferramentas), menu contextual e atalho.
taneo
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9.4 Visao de Outline

A Visdo de Outline apresenta a estrutura do documento NCL como uma 4rvore, permitindo aos autores navegarem no

documento.

Outline View © X

- ncl (syncEx)
- head
+ connectorBase (connectorBase1)
- || body (body1)
B port (entry)

- '“'#| media {animation)
property (width)
property (height)
property (zIndex)
area (segDrible)
area (segPhoto)
media {chorg)
media {drikle)
property (left)
property (top)
property (width)
property (height)
property (zIndex)
- ®¥ media {photo)

property (left)
property (top)
property (width)
property (height)

9.5 Visao de Propriedades

A Visao de Propriedades apresenta o conjunto de propriedades da entidade selecionada. Essa entidade selecionada por
ser, por exemplo, uma regido na Visdo de Leiaute, um objeto de midia na Visdo Estrutural etc.
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Properties View © X

area:segDrible

Attribute Value

id segDrible
beqin 125

first

beginPosition
end

last
endPosition
clip

label

text

coords
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9.6 Visao Textual

A Visdo Textual permite aos usudrios interagirem diretamente com o cédigo-fonte da aplicacdo NCL. Ela é um editor
de texto avangado focado na linguagem NCL e traz funcionalidades como: coloracdo sintdtica, sugestdo de cédigo
contextual e formatacdo de cédigo.

A Visdo Textual é recomendada especialmente para usudrios avangados e que se sentem a vontade com a sintaxe XML.

NCL Textual View © X

10 g </causalConnector=

11 <causalConnector id="onBeginStart"=>

12 <simpleCondition role="onBegin"/=

13 <simpleAction role="start" max="unbounded" qualifier="par"/=
14 - </causalConnector>

15 5 <causalConnector id="onEndstop"=

16 <simpleCondition role="onEnd"/=

17 <simpleAction role="stop" max="unbounded" qualifier="par"/>
18 |- </causalConnector>

19 |- </connectorBase>

20 |- </head>

21 <body id="bodyl">

ZZZ <port id="entry" component="animation"/>

23 = <media id="animation" src="../media/animGar.mp4">
24 <area id="segDrible" begin="12s"/>

25 <area id="segPhoto" begin="41s"/>

26 <property name="width" value="100%"/>

27 <property name="height" value="1l00%"/>
28 <property name="zIndex" value="2"/>

29

30 - </me

31 <mec property oro.mpa"/>
320 <mec rible.mp4">
33 B>

34 TE"f=

35 18.5%" />
36 "18.5%" />
37 "3/

38 - </me

390 <mec oto.png"=>
40 B>

41 <pruoperty name=-topTvatue=-uo. %" />

42 <property name="width" value="18.5%"/>
43 <property name="height" value="18.5%"/>
44 <property name="zIndex" value="3"/>

45 <property name="explicitDur" value="5s"/>

9.7 Visao de Regras
Permite a definicdo de uma base de regras, as quais podem ser utilizada em switchs para adaptacao do conteido a ser

apresentado.

v |

Element Id Variable Comparator Value
-| ruleBase ruleBasel
rule rulel user.age v leq v 10

-| compositeRule(and) compositeRulel

rule rule2 system.language . v | english

eq
BT . - |- 4 |
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9.8 Visao de Validacao

A Visdo de Validacdo é responsdvel por notificar erros e alertas no documento NCL. A figura a seguir apresenta um
exemplo.

Validator Plug-in @ X

Elemento Mensagem

X

X link There are 0 elements with attribute 'role'='stop’. The minimum cardinality is 1.

9.9 Visao de Execucao

Possibilita ver o resultado da execucgdo do seu projeto.

RunView © X

Laboratorio de Sistemas Multimidia

“Formakica

Todo: Executar embedded or not embedded
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Como mudar o tema do NCL Composer
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Indices and tables

* genindex
* modindex

e search
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Index

Symbols
—help, -h

nclcomposer command line option, 9
—version, -v

nclcomposer command line option, 9

N

nclcomposer command line option
—help, -h, 9
—version, -v, 9
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